
A GUIDE TO THE BROOKINGS 
EITC INTERACTIVE WEBSITE 

How to Use Tax Credit Data in Your Outreach Efforts 
Get It Back Campaign 

Center on Budget and Policy Priorities

NAVIGATING BROOKINGS’ EITC INTERACTIVE

SAVING THE DATA FILE WORKING WITH THE DATA FILE

CREATING DATA REPORTS ABOUT 
YOUR AREA 

USING DATA POINTS TO CREATE A 
DATA SUMMARY REPORT

1



OVERVIEW 
The Brookings Institution provides 
an Earned Income Tax Credit (EITC) 
Interactive data finder that can reveal 
important information about EITC 
claims and tax filing in your area. You 
can use statistics from the data to make 
the case for the need for tax credit 
outreach and to develop your outreach 
strategy. For example, it can help you 
educate coalition partners, establish 
relationships with new organizations, or 
inform funders. The site includes a helpful 
User Guide that you can review to better 
understand the data and terms used. 

Purpose

This guide is designed to introduce you 
to how the EITC Interactive works, what 
information is available, and how you can 
use the data to support your tax credit 
outreach campaign.

NOTE
Information provided in this guide is based 
on Brookings’ updated EITC Interactive 
for Tax Years 2011 and later. Data from 
Tax Years 1997 to 2010 are available upon 
request by emailing NHolmes@brookings.
edu, or through the older version of the 
EITC interactive.
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STEP 1: CHOOSE A “TAX YEAR.” 

STEP 2: PICK A “GEOGRAPHY TYPE.”

There are eight options to choose from, as 
shown in Figure 1.

STEP 3: SELECT YOUR “STATE.”

Now you are ready to download data based 
on your preferences. For example, choosing 
“2012” as the “Tax Year” and “County” under 
“Geography Type” produces data for all 
counties within your selected state for 2012.
 
STEP 4: CLICK THE BOX THAT SAYS 
“DOWNLOAD DATA FILE (CSV).”

Once you click the download box a dialog 
box will appear on the screen. Select the 
option to open the file. It will automatically 
open in your spreadsheet program. 

The EITC Interactive allows you to view tax return data based on three categories: (1) Tax 
Year; (2) Geography Type; and (3) State.

NAVIGATING BROOKINGS’ 
EITC INTERACTIVE

Figure 1: Choose between the eight “Geography 
Types” Brookings provides.

Figure 2: After selecting the Tax Year, Geography Type, and State, click the “download data file” box.  

Note: You can select the “Geography 
Type” you prefer. The examples in this 
guide will use the “County” Geography 
Type.

Note: Your web browser’s settings may be set to “automatic download.” 
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NOTE
Google Chrome does not provide users an option to 
open the file from the initial download screen. You 
must first save the data file to your computer as 
a CSV file, then change the file type as described 
above.

Saving your data will ensure it is easily 
accessible to analyze.

Step 1: Go to “File” and click “Save As.” 

Step 2: Change the file type from “CSV” 
to the spreadsheet format you prefer to 
ensure any changes you make will be 
saved and can be formatted as you like.  

Figure 3: CSV files will not save any changes you make to the data, so you must change and save the 
file in a different format.

WHO QUALIFIES FOR IT?

TIP: For organizational purposes, rename 
your data file after the Geography 
Type, State, and Year you selected (i.e. 
“County_Idaho_2012”).
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A quick glance at the spreadsheet will reveal 
many numbers and labels that may initially 
seem complex. Here are some tips for 
navigating the data.  

• Understanding variable names: The 
EITC Interactive returns the data file with 
abbreviated headings for each column. 
Column headers contains a prefix and a 
variable name. The prefix “t” represents 
all the tax returns filed, while the prefix 
“e” only counts returns claiming the 
EITC.

WORKING WITH THE 
DATA FILE

• You can find a complete list of variable 
names and their corresponding 
descriptions using the Brookings EITC 
Interactive User Guide. Review all the 
different variable types and descriptions. 
This will help you to determine which 
categories are most important to explore. 
The table below contains a sample list of 
some variables that can be useful for tax 
credit outreach campaigns to evaluate.

Variables
Variable Name 

(2013 variable names differ slightly)
Variable Descriptions

return Total number of returns
eic Total number of returns receiving the EIC
ctc Total number of returns receiving the CTC
actc Total number of returns receiving the 

refundable portion of the CTC
ref Total number of returns receiving a refund
self Total number of returns that were prepared 

by taxpayer
paid Total number of returns prepared by a paid 

preparer
vol Number of returns prepared by volunteer 

orgs (VITA, Military VITA and TCE)
itin Total number of returns files with an 

Individual Taxpayer Identification Number

Note: 2013 data variables include “13” as a suffix. There are also some differences in 
the abbreviations used.
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Figure 4: Use “AutoFit Column Width” to resize all columns in your spreadsheet to completely display 
the information in the cells. 

Figure 5: Add a filter to your data sheet.

• Removing or hiding unwanted data 
columns: Data files come populated with 
a comprehensive range of information, 
therefore you may want to delete or hide 
certain columns to more easily work with 
the data of interest. To hide unwanted 
columns:

Step 1: Right-click the header of the 
unwanted column.

Step 2: Click “Hide.” (To unhide a 
column, double click the space between 
the columns where the hidden column 
would appear.)

• Organizing the spreadsheet: You may 
notice number signs (i.e. ######) in 
some of the cells in your data file (see 
Figure 4). Spreadsheet programs like 
Excel automatically do this to indicate 
that there is a number too large to 
display entirely in the cell. You can adjust 
the width of the columns to reveal the 
actual numbers. 

For Excel:

Step 1: Hold Control + A (Mac: 
Command + A) to select all the data.

Step 2: Under the “Home” tab go to the 
“Cells” group, click “Format” and select 
“AutoFit Column Width.” All the columns 
automatically adjust and the number 
signs disappear to reveal all the data.

• Add a filter to a data column: Filters 
allow you to sift through information 
quickly and efficiently. To add a filter to a 
column, select the entire desired column, 
including the first row with the header. 
Go to the “Data” tab at the top of Excel 
and then click “Filter.”

Example: In Figure 5, a filter has been 
added to the “County” column. The 
“County” cell contains a dropdown menu, 
which allows you to choose the county 
you want to display. After you click on 
the dropdown arrow, check the “Select 
All” box to deselect all options.  Then, 
check the boxes that match your desired 
search and select the “OK” button.
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CALCULATE THE PERCENTAGE OF 
TAX RETURNS WITH INCOMES 
BELOW $30,000

Figuring the percentage of tax returns with 
income below $30,000 will allow you to gain 
an understanding of how much of the overall 
population in your geographic area lives at 
a lower-income level.  Is this high or low 
compared to other areas in your state?  This 
is the main target group to receive VITA 
services and nearly all eligible filers who do 
not claim the EITC are in this group.

Data from the Brookings EITC Interactive can be used in a variety of ways to support your 
tax credit outreach campaign. For example, the data may reveal information that will 
encourage your organization to expand the promotion of VITA sites or identify places to 
establish new VITA sites. Or, the data may provide important statistics to highlight in media 
releases. Most importantly, simply knowing more about tax credit refunds in your geographic 
location will allow you to create benchmarks for the future. The following information will 
help you understand how you can use the data to create informative reports about your 
geographic location.

DATA POINTS TO HIGHLIGHT 
Below you will find a list of data points and their corresponding descriptions that you can use 
to gain a better understanding of your geographic location.

DETERMINE THE NUMBER OF TAX 
RETURNS FILED IN YOUR AREA 
WITH INCOME BELOW $30,000

Calculating the number of tax returns filed 
in your area with income below $30,000 can 
help provide a rough idea of the number of 
lower-income workers that may be eligible 
to claim the EITC. Remember, this number 
will includes workers without children, many 
of whom may not even meet the lower 
income limit to claim the EITC (around 
$14,000) or who are under age 25 and don’t 
qualify.

CREATING DATA REPORTS 
ABOUT YOUR AREA 
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CALCULATE THE PERCENTAGE 
OF FEDERAL TAX RETURNS THAT 
CLAIMED THE EITC

Determining the percentage of tax returns 
that claim the EITC will help you identify 
patterns of EITC participation in your area. 
You can compare this to the statewide 
percentage or to the rate in other 
counties. You can look at the rate in the 
cities and towns within a county to see if 
EITC claims are concentrated in particular 
areas.

DETERMINE HOW MANY EITC 
FILERS HAD INCOMES BELOW 
$30,000

Assessing how many EITC filers had incomes 
below $30,000 may help you approximate 
how many tax filers in your area are missing 
out on claiming the EITC. 

DETERMINE THE PERCENTAGE 
OF EITC FILERS WHO HAD 
INCOMES BELOW $30,000

Identifying the percentage of EITC filers who 
had incomes below $30,000 may help you 
approximate how many tax filers in your 
area are missing out on claiming the EITC, 
since eligible lower-income filers are more 
likely to not claim it (Remember, though, 
that lower-income workers who 
don’t claim the EITC may 
also not be filing tax 
returns at all.)

CALCULATE HOW MANY 
TAXPAYERS WITH INCOMES 
BELOW $30,000 DID NOT CLAIM 
THE EITC

You can now estimate how many tax filers 
with incomes below $30,000 did not claim 
the EITC. As noted above, they may not 
all qualify, but you can use this number to 
estimate further, based on your knowledge 
of your community. 

DETERMINE THE AVERAGE EITC 
CLAIMED IN YOUR AREA

This can help you explain how 
valuable the EITC is to workers in your area 
and show the value of the EITC to those 
eligible workers not claiming it. Comparing 
the average EITC in your area to the 
statewide average, or the average in other 
communities, can provide insight to whether 
EITC recipients in your area are lower or 
higher income or more or less likely to be 
workers not raising children. 
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CALCULATE THE PERCENTAGE OF 
TAX RETURNS THAT WERE FILED 
BY PAID PREPARERS

Determining the percentage of all tax 
returns that were filed by paid preparers will 
help you understand how prevalent the use 
of commercial tax preparation is overall in 
your area.

CALCULATE THE PERCENTAGE OF 
EITC TAX RETURNS THAT WERE 
FILED BY VOLUNTEER PROGRAMS, 
SUCH AS VITA AND TCE

Use this number to compare the percentage 
of volunteer prepared returns statewide or 
in nearby counties to get a picture of how 
much room for growth there may be.

CALCULATE THE PERCENTAGE 
OF EITC TAX RETURNS 
THAT WERE FILED BY PAID 
PREPARERS

Comparing the percentage of EITC tax 
returns that were filed by volunteer 
programs to the percentage of all tax 
returns filed by paid preparers will help you 
gauge whether EITC filers are more or less 
likely than other taxpayers in your area to 
use paid preparers.
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DATA POINT REFERENCE SHEET
This chart lists equations for each of the previous data points. Once you’ve calculated the 
data points of most importance to your outreach efforts, you can prepare a data summary 
report.

Data Point Formula

Example: 
Bonneville County, 

Idaho
1 Tax returns filed with 

income below $30,000
tagi0+ tagi5+ tagi10+ 
tagi15+ tagi20+ tagi25 = 
Data point #1

(3,835)+(3,684)+(3,735)+
(3,493)+(2,932)+(2,450)= 
20,129

2 Percentage of tax returns 
with incomes below 
$30,000

(tagi0+ tagi5+ tagi10+ 
tagi15+ tagi20+ tagi25)/
treturns * 100 = Data 
point #2

(20,129/41,457) * 100 = 
49%

3 Percentage of federal tax 
returns that claimed the 
EITC

eeic/treturns = Data point 
#3

(9,456/41,457) * 100 = 
23%

4 Percentage of federal tax 
returns that claimed the 
EITC

eagi0+ eagi5+ eagi10+ 
eagi15+ eagi20+ eagi25 = 
Data point #4

(936) + (1,443) + (1,707) 
+ (1,234) + (986) + (926) 
= 7,223

5 Percentage of EITC filers 
with incomes below 
$30,000

(eagi0+ eagi5+ eagi10+ 
eagi15+ eagi20+ eagi25)/
ereturns = Data point #5

(7,223/9,456) * 100 = 
76%

6 Taxpayers with incomes 
below $30,000 that did not 
claim the EITC

Subtract #4 from #1 = 
Data point #6

20,129 – 7,223 = 12,906

7 Average EITC claimed in 
your area

eeicam/eeic = Data point 
#7

$22,059,661/9,456 = 
$2,333

8 Percentage of tax returns 
that were filed by paid 
preparers

(tpaid/treturns) * 100 = 
Data point #8

(20,747/41,457) * 100 = 
50%

9 Percentage of EITC tax 
returns that were filed by 
volunteer programs

(evol/ereturns) * 100 = 
Data point #9

(726/9,456) * 100 = 7.7%

10 Percentage of EITC tax 
returns that were filed by 
paid preparers

(epaid/ereturns) * 100 = 
Data point #10

(4,683/9,456) * 100 = 
50%

Note: Variables for 2013 data may differ slightly. 
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A total of 41,457 federal tax returns were 
filed in Bonneville County. Forty-seven percent 
of these federal tax returns, or 20,129, had 
incomes below $30,000. Twenty-three percent 
of federal tax returns claimed the EITC. Of 
those who claimed the EITC, 76 percent 
had incomes below $30,000. Approximately 
12,906 taxpayers with incomes below $30,000 
did not claim the EITC.

In 2011, 9,456 tax returns claimed the EITC. 
The sum of EITC refunds in Bonneville County 
was more than $22 million. Countywide, the 
average EITC claimed was $2,333, slightly 
higher than the statewide average of $2,186. 
Fifty percent of all tax returns in Bonneville 
County were filed by a paid preparer. 

Now that you are familiar with some data points, you can compile a data report that 
summarizes the financial make up of your geographic location. Data summary reports are an 
excellent way to present data to your organization, public officials, and the community at-
large. There is no right or wrong way to develop your data summary report. You may choose 
to incorporate the data points mentioned above, or choose from the other variables provided 
by the Brookings EITC Interactive. In addition, including information from other credible 
resources may enhance the effectiveness of your report. Below you will find a data summary 
report on Bonneville County, Idaho for tax year 2011. Aside from the Brookings data, the 
data summary report below contains statistics from federal and state resources. When using 
data points in your report, you may want to use footnotes or endnotes as a way to cite your 
data.1

USING DATA POINTS TO CREATE 
A DATA SUMMARY REPORT

CASE EXAMPLE: 
BONNEVILLE COUNTY, 

IDAHO

Data Summary Report

Bonneville County is located in the eastern 
region of Idaho that borders Wyoming. Areas 
outside of the county’s major urban center, 
Idaho Falls, can be classified as rural.2  With 
a population of 106,684, it is ranked as the 
fourth largest county in the state.3  The Idaho 
Department of Labor lists “trade, utilities 
and transportation” as major job sources.4  
Bonneville County is also noted as a health 
care and retail hub. Census data from 2007-
2011 show that 11 percent of persons in 
Bonneville County live below poverty level.  

1 To create a Footnote or Endnote, (1) Place the cursor in the document where you want to insert the note. (2) Click 
on the “References” tab in Microsoft Word. (3) Select “Insert Footnote” or “Insert Endnote” depending on where you 
want to place your references. (4) Word will automatically format the note and you can type in the reference.
2 http://www.ers.usda.gov/datafiles/Rural_Definitions/StateLevel_Maps/ID.pdf
3 http://quickfacts.census.gov/qfd/states/16/16019.html
4 http://labor.idaho.gov/publications/lmi/pubs/bonnevilleProfile.pdf
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Volunteer programs, such as VITA and TCE, 
prepared 2,807 tax returns in Bonneville 
County, or six percent of all returns – about 
726 of these were EITC returns.  Statewide, 
volunteer organizations prepared three 
percent of all tax returns and three percent of 
EITC returns. 

Fewer than 20 percent of all tax filers claimed 
the ACTC, whereas 64 percent of filers 
claiming the EITC also claimed the ACTC. 
Among EITC filers, the average ACTC was 
$1,500.

Putting the Data Summary Report into 
Practice 

Demographic and fiscal information can help 
you determine where your community stands 
and how to proceed to set realistic goals for 
outreach and VITA services in your area. For 
example, the percentage of returns filed by 
volunteer programs in Bonneville County is 
twice the statewide percentage. Would an 
appropriate goal be to increase the overall 
number served, to increase the number of 
EITC eligible families served, or to look at 
neighboring counties to see if there is greater 
need to boost services there? 
Nearly 13,000 tax filers earning less than 
$30,000 in Bonneville did not claim the EITC, 
which is larger than the total 
number of EITC claims in the 
county. What does Census data 
suggest about the proportion 
of those earning under 

$30,000 who are families with children, or 
very low-income individual workers, compared 
to those not raising children who earn more 
than the EITC income limit but less than 
$30,000? Does there appear to be a segment 
of lower-income families who don’t claim the 
EITC?  Are there themes or commonalities 
among eligible non-claimant workers not 
raising children? The data points above 
can help you formulate strategic outreach 
approaches different groups of workers.
 

CLOSING
This case example illustrates how you can 
use analyzed data to help advance your tax 
credit outreach campaign and present the 
need for outreach. Data from the Brookings 
Institution’s EITC Interactive can be used to 
set outreach goals, write funding proposals, 
or help inform the public about your 
community’s financial state and opportunities 
for growth. Depending on your campaign, 
this may be a good research project for a 
graduate student or community organizer to 
conduct. 

Email questions about this guide to: 
eitcoutreach@cbpp.org.
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